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PREFACE:

Before we begin....

A little explanation of two very important terms you'll hear a lot as we explore the world of Inkscape....

FILL STROKE

and

A plain, one-dimensional line in Inkscape is called the Stroke, whereas a two-dimensional shape enclosed
within or between a Stroke is called the Fill. Both have nodes that can be edited, although a Stroke can
only use these to modify its course, but not alter any height and width values (although you can alter a
preset “thickness”) A Fill, on the other hand, has editable nodes throughout its shape, allowing you to
modify the shape freely.

Note that while the distinction makes it sound as though a Stroke is forever locked into a line shape, and a
Fill forever locked into a block shape, a little creativity can easily blur the distinction:

FILL STROKE
and cﬁwf%/m/‘;w

The more you work with Inkscape, the more you'll be able to
appreciate the value of both fills and strokes. For the time being,
just note that the union of the two helps form the basis for the
Anime cel look that we'll be working with going forward. Please
note that while every shape in Inkscape is composed of fills and
strokes, they may not be immediately categorized as such. Preset
rectangles and blocks of text, for example, can only be modified as
standalone shapes until you physically convert them into editable paths or strokes. Such a preset shape
without any nodes is known as an Object.

Note also that the combination of a Fill and a Stroke is officially called a Path. Hence the shape
immediately about this is a Path, and hence the reason why this term will appear often in this tutorial.

Now then, onto a detailed explanation of all those icons in the Inkscape Toolbox....



=

|
1

P

CHAPTER 1:

| nkscape Tool box
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SELECTION TOOL
Official Descriptor: “Select and Transform Objects”

Keyboard Shortcut: F1

The Selection Tool is used to manipulate the most basic components in Inkscape, and thus destined to
become your most commonly used tool second only to the Edit Tool. With this you can select Paths,
Objects or Groups, and click-n-drag them around the canvas at your bidding.

In addition, selecting an object with this tool automatically enables the Scale
handles, which can be used to transform the size and width of the selected object
much like in Photoshop.

Simply clicking and dragging the handles will resize the object towards that single
direction (the object origin, which appears like a little crosshair, will stay put on
the opposing end of the object).

However, if you keep the SHIFT key pressed while you're resizing, you'll be able to resize the entire object
from its epicenter instead (the crosshair will likewise stay put in the center). Similarly, keeping the CTRL
key pressed enables Keep Aspect Ratio, which allows the object to be grown or shrunk uniformly.=

If rather than Scale you want to Rotate, you need not do anything more to the ’
selected object than select it again. Double-selecting an object will enable the
Rotate handles

For simple rotation around the object's epicenter, use the arrows in the corner.
Keep the CTRL key pressed in order to rotate at major angles (in case you want to,
say, rotate to a precise 45i or 90i angle), and keep the SHIFT key pressed if you
need to rotate around the object's opposing corner.

Manipulating the middle handles will actually Skew rather than Rotate the object,
a very useful, Photoshop-like feature which will be invaluable when creating forced
perspectives. The CTRL and SHIFT key work the same way here as they do with
the rotating handles.

Please note that | specifically stated “double-selecting” (press left mouse key slowly
two times) rather than “double-clicking” (quickly press left mouse key twice).
When you double-click an object with the Selection Tool, you'll automatically be
redirected to the editing tool of that particular object. More on the other editing
tools later.

One final note: the Selection Tool can be used to select more than one object at a time. Simply keep the
Shift key pressed while selecting other objects, or reselect them with the Shift key pressed to remove
them from the group. You can also select multiple objects by clicking and dragging your mouse.



s EDIT TOOL
Official Descriptor: “Edit path nodes or control handles”

Keyboard Shortcut: F2

Having the ability to edit an object's shape, at any given time and with utmost precision, represents the
true bread and butter of vector graphics drawing. Without this, there would be no point to look beyond
raster graphics, as you would only be able to shift static objects around in a canvas (yes, that gets boring
very quickly).

If you have a background in 3D object editing, you will recognize the importance of editing points/nodes in
order to sculpt your masterpiece from little more than a mere 3D cube. The exact same principle is true
with vector graphics, where you can take a preset shape and edit its nodes to create something drastically
different:

BEFORE AFTER

and

When you select an object with the Edit Tool, you will get either the object's native editing options or the
same shape with its nodes visible in gray. Either way, the Scale or Rotate handles will dlsappear entirely
in this mode - not to say you can't resize an object with the Edit Tool, but you will .

have to do it manually by manipulating the nodes directly. Note that if you select
anywhere outside the object's Stroke or Fill, this will deselect it and hide the nodes.

D In order to select an individual node, simply left-click on one or click-
; and drag your mouse over it if it's particularly hard to get a hold of.
i Once selected, you'll already be able to move the node around, either
by dragging it with the mouse or pressing the Arrow keys on your
i ' keyboard. When using the keyboard only the Shift key will do anything dlfferent -in thls
. case, make the node move in wider increments. Neither the Ctrl nor Alt key will do
' anything different than using the Arrow keys only, which will make the node move slowly
. one pixel at a time. Thus, the Arrow keys are excellent for precision placement of a node.
'V " In addition to movement, you can also use the Tab key or Alt+Tab to switch between other
""""""" nodes, or Delete/Backspace to remove a node.

Dragging a node with your mouse, on the other hand, offers a far more dynamic
experience. If the extra freedom is too imprecise for your needs, you can use the Ctrl
key to keep the mouse locked in a straight horizontal or vertical course. Likewise,
pressing Ctrl+Alt while using your mouse will keep it locked in the perceived course of
the node. This is pretty handy when you want to extend imprecise sections of a shape,
such as the crown displayed in the above example.

More importantly, when you keep the Shift key pressed while dragging a node, you will
pull out its handle rather than the node itself. The handle, or bezier curve, is the line with
a circular end attached to the node and is used to curve a Stroke, edge of a Fill or both.
You only need to drag out with the Shift key once, after which the handle sticks around and
can be edited later whenever you reselect that node.

Dragging the handle end alone allows you to move the handle freely, allowing the creation
of more organic-looking curves. However, keeping the Ctrl key pressed while dragging a
handle end locks the handle at preset angles -- although be warned that left-clicking on a
handle end with the Ctrl key pressed will collapse the handle back into its node.




Speaking of which, Ctrl clicking the node itself allows you to manually cycle through the three different
handle bar options:

Corners Smooth Symmetric
>
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Corner handles allow you to modify the length AND direction of the handle, making it possible to create
curved edges with a point. Unlike the other two handles, corner nodes are displayed as diamond-shaped
points. You'll almost always work with these types of handles.

Smooth handles can be different lengths, but their direction is locked in place, forcing the handles to
rotate in unison. Smooth nodes are displayed as square points.

Symmetric handles must always be of of the same length and direction, making for the most rounded,
circular-like edges of all. Like with the smooth nodes, Symmetric nodes are displayed as square points.
These will also be used extensively in Anime cel artwork.

Like with the Selection Tool, you can use either the Shift key technique or the click and drag technique
in order to select multiple nodes. You will also be able to see the handles for each respective node (if
available); however, you will not be able to modify more than one pair of handles at once,... that is, unless
you use the Submenu.....

Up until now you know how to summon these options manually, but the Edit Tool also supplies an
additional Submenu that can provide you both with greater convenience and additional functionality:
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A) Insert New Nodes Into Selected Segments
When selecting more than one node, pressing this button adds
an additional node between each consecutive pair of nodes.
Click this button with two nodes selected will add a third
between them; pressing them again with the 3 nodes selected
will create two more for a total of 5 nodes, and so on.

~—

B) Delete Selected Nodes

This function is actually little different from selecting one or \>\ >
various nodes, and pressing the Delete or Backspace buttons. :
i |
C) Join Selected Endnodes

An Endnode is a node that is only attached on one side but not the other. This is quite evident
when drawing a single stroke, since both ends of the line are considered the Endnodes.

However, in an object with both a Fill and Stroke, this is a lot more evident when you see a
gap in the Fill that is not covered by a Stroke. Although this looks like a defect, we will be
exploiting this feature extensively when drawing Anime cel art.

This button is used to unite two end-nodes together, thus \\ ‘>\

plugging the hole by creating a single point. This point can then 3 :
be rounded out using any of the 3 handle bar options. ! /



D)

K)

Join Selected Endnodes With a New Segment
This also plugs any of the aforementioned Endnode gaps;
however, this is gone about with this button by creating a new
stroke between the end nodes. This particularly useful
whenever you're drawing a new shape, but you close out of it
prematurely and need to resume where you left off.

Split Path Between Two Non-Endpoint Nodes.

This is the exact reverse of the previously mentioned process.
As | stated previously, we will be using these gaps extensively
when creating Anime cel art, so it's always good to know we can
create these gaps on demand.

Break Path At Selected Nodes

This one is a bit tricky to use, but not to say you couldn't find a good use for it! It also creates a
gap in a shape, but unlike in the previous example where the stroke between two nodes is
deleted, this function splits one node into two and creates a gap between them. Thus, from a

single node split by this option, you can have a gap cleaved between the two.

This may not sound useful, until you realize that you can do this
with more than one node. For example, if you select two nodes
and split them as such, you can literally split the object
completely into two different sections.

Make Selected Nodes Corner

As it says, this turns all currently selected nodes into Corners. |If
you do this on a regular node, there won't be any apparent
change done to it. But if you do the conversion over preexisting
Smooth or Symmetric nodes, then you'll see the square nodes
turn into diamonds.

Make Selected Nodes Smooth
This turns all currently selected nodes into Smooth ones. Unlike
with Corner nodes, new handle bars will always appear >
automatically every time this button is pressed. These can then
be modified as described above.

Make Selected Nodes Symmetric

This turns all currently selected nodes into Symmetric ones.
Unlike with Corner nodes, new handle bars will always appear >
automatically every time this button is pressed. These can then
be modified as described above.

Make Selected Segments Lines

When two or more nodes are selected, this function deletes the
handle bars between them in order to create perfectly straight
lines.

Make Selected Segments Curves

When two or more nodes are selected, this function restores the
handle bars between them in order to allow you to create
curves (either by manipulating the handles, or moving the
nodes about).

Convert Selected Object to Path

All newly created objects (e.g., Squares, Circles) and text do not automatically allow you to edit
their nodes. Press this button in order for you to convert these preset objects (which have their
own options and submenus) into Paths. CAUTION: Like with 3D editing, this process is
irreversible, so make sure you don't need to go back to the original object format (especially
relevant when it comes to adding Text).



M) Convert Selected Object's Stroke to Path

This converts any Stroke (regardless of whether it is

accompanied by a preexisting or not) into a Fill. Once it

becomes it's own Fill, then you can assign a fresh new

Stroke around it. This is an incredibly useful function that

will be detailed in depth in a later chapter. But just to give

you an idea of the power of this function, note that the

squiggly Fill featured in the Preface was created by turning

a bland teal-colored stroke into a Fill, and then modifying the Fill's nodes to crate a variable-
width line effect.

N) Show the Bezier Handles of Selected Nodes
This is usually enabled by default, since it's usually convenient to SEE what the handle bars look
like and where they're positioned. In the event you need to hide these handles, deselect this
function. However, | can't really think of a situation where you need to do this - usually when |
want to see an object in its plain form (without handles or nodes or bounding boxes), | just click
out of the Edit Tool entirely. :)

ZOOM TOOL

Official Descriptor: “Zoom In Or Out”
Keyboard Shortcut: F3

This is a fairly straightforward tool and not exactly worthy of its own section, but here we go anyway....

As in Photoshop (and just about every other image editing program), you use this tool to zoom in and out
of sections of your image. However, since we're dealing almost exclusively with vector graphics in
Inkscape, the quality of the onscreen Paths will not degrade as you zoom down. The only exception to
this rule are bitmaps (raster graphics) imported into Inkscape, as you can see with a 2:1 Zoom In:

Zoom 1:1 Zoom 2:1

Vector Raster Ct or R as

O% mw

When the tool is selected, Left-Click to zoom in, or Shift+Left Click to zoom out. For further control, you
can hold the CTRL key while scrolling the mouse wheel up or down in order to zoom on demand.

Additionally, you can drag a bounding box on any part of the screen in order to zoom in on that particular
section - a very valuable feature in order to reach tiny areas of a complicated image, but be wary if you
use a tablet as any small flick with the Zoom Tool enabled could be interpreted as a bounding box zoom.
Should this ever happen and you focus on an infinitesimal section of white space, just press the “4”, “5"” or
“6" keys to zoom back to [or close to] the full page width and start over.

For more precision (for example, to prevent the aforementioned zoom problem), use the “-" or “+”
keyboard shortcuts to Zoom In or Out respectively. Although the Zoom Tool does have its own Submenu,
these are essentially zoom presets and all fairly self-explanatory.



RECTANGLE TOOL
E Official Descriptor: “Create Rectangles and Squares”

Keyboard Shortcut: F4

The Rectangle Tool is yet another feature ubiquitous across drawing programs. Anyone migrating from
Photoshop, for example, will recognize a similar vector square tool in their menu bar, and in fact Inkscape's
version functions the same way (albeit perhaps more intuitively).

Once the tool is selected, simply clicking and dragging in any part of the screen will produce a freeform
rectangle. And just like with the Scale handles,holding the SHIFT key will dragging will produce a
freeform rectangle from your mouse position, whereas holding the CTRL key while dragging will produce a
perfect square. (In case you're wondering, yes SHIFT+CTRL does produce a perfect square from your
mouse position.)

Once the rectangle (or square) is created, notice that the object created \
does not have node handles yet, but rather its own special set of handles
including two square white boxes (shown by the red arrows) and one white
circle (shown by the arrow). Even when you select the Edit Tool, the
Square Tool handles will not disappear unless you convert the rectangle
into an editable shape. The two white boxes are used to adjust the height
and width of the rectangle - while it may look like you can do the same thing
with the Scale handles, Square Tool handles
accomplish this WITHOUT increasing the width of the
strokes. In essence, these handles are used to adjust ‘
the object's size with greater precision.

The white sphere is used to round the corners of the rectangle. This “rounding” handle
will operate up until the center of the square, where it basically becomes a circle.
Note that when dragging the sphere for the first time, you'll discover a second sphere
underneath it. This sphere adjusts the horizontal rounding, while the one you dragged
initially modifies the vertical rounding. When utilizing these handles properly, you can
convert a rectangle into a pill or oval-shaped object.

The Submenu provides spin buttons to control the rectangle's height, width and vertical/horizontal
rounding, including an option to convert the control units from pixels to any other favored unit of
measurement (e.g., inches, centimeters). Notice also the button labeled “Not Rounded” -- in the event
your rounding yields undesirable results, rather than going through the trouble of returning the handles
back to their position, you can just click this button to convert your object back to a square/rectangle.

This basically covers all that you can do with a rectangle shape. Once you're ready to convert this into a
more complicated shape, don't forget to click on the Convert Selected Object to Path button in the
Edit Tool Submenu. Likewise, you can also press CTRL+SHIFT+C to process the conversion into
editable nodes instantly.

CIRCLE TOOL
O Official Descriptor: “Create Circles, Ellipses And Arcs”

Keyboard Shortcut: F5

The Circle Tool differs very little from the Square Tool, so using the
same combination of CTRL and SHIFT keys while dragging the mouse
during circle creation will produces the exact same results as before.
The circle or ellipse produced will also have a very familiar set of
handles: two square ones shown by the red arrows, one round one by
the green arrow.

Here as before, the square handles are used to adjust the height and
width of the circle. However, unlike with the Square Tool, the round
handle (or rather handles once you actually move them) is used to




“carve” the circle into an arc shape. When moving the round handles, there are two possible arcs that you
can produce depending on whether your mouse is positioned A) within the circle or outside of it:

Open Arc

or

This is an interesting feature, but unless you plan to draw Pacman-like shapes somewhere (perhaps for
Gentoo Linux-tan?) or vectorized pizza, this is not something we'll be using much for our Anime renditions.

Notice that the Submenu for this tool is even less constructive, as it only offers controls to modify the arc
values. The Start and End spin buttons will fine-tune the position of the arc handles, the Open Arc
checkbox turns a closed “Pacman” Arc into an open one (thus making the name fairly self-expanatory), and
the Make Whole button will turn an arc back to its original circle shape - very handy in case you ever
create an arc accidentally.

Once again, in order to turn the circle shape into an editable Path, you need to click on the Convert
Selected Object to Path button in the Edit Tool Submenu, or press CTRL+SHIFT+C.

STAR TOOL
Official Descriptor: “Create Stars and Polygons”
Keyboard Shortcut: *

Unlike it's two predecessors, the Star Tool creates preset shapes that are actually FUN to work with! The
name is actually a little misleading, as one can create far more than simple star shapes with this tool (in
fact, I'm only naming it “Star tool” because “Polygon Tool” will confuse Photoshop migrants).

First of all, notice that instead of white squares or circles, you have one white | A |
diamond in the outer tips of the object that modifies the Tip Radius (pointed to by \
the blue arrow), and another white diamond at the base of the shape that modifies |

(you guessed it!) the Base Radius (next to the purple arrow).

If for any reason you have trouble conceiving of the notion of
“radii” on such a complex polygonal shape, visualize the star as
being intersected by two circles, one inner (the “base”), the other 1
outer (the “tips”). As you'll see later however, modifying these ... # . N
handles not only control the size of the radii, but also their

relative positioning as well.

All stars and polygons are drawn from the center outward (not from a corner) and perfectly proportionate,
so the SHIFT key will have no effect when dragging a new shape and the CTRL key only performs some
mundane angle locking. On the other hand, CTRL, SHIFT and SHIFT+ALT while dragging the Tip Radius
or Base Radius handles produce very significant results:

CTRL (any) SHIFT (any) SHIFT+ALT (any) no key (Tip) no key (Base)




Dragging while holding the CTRL key helps lock the star's spokes in place, so you can increase the size of
the spokes (via the Tip Radius handle), or decrease the size of the base (via the Base Radius handle) as
much as you want.

Dragging while holding the SHIFT key rounds the spoke tips (via the Tip Radius handle) or the base
edges (via the Base Radius handle), although at the end of the day the effect looks the same either way.
Bear in mind that if you round too much, the shape will intersect onto itself, thus creating a kaleidoscope-
like effect that may (or may not) be desirable to you.

Dragging while holding the SHIFT+ALT keys will randomize the spokes of the star, thus eliminating any
symmetry and deforming the overall shape. This may be useful if you play to render explosions, stars or
sunflares, although proceed with caution as it's very easy to make a mess of the shape if you randomize
using the mouse.

Even if you don't use any of these keys, as you can see you are still able to do interesting things with just
mouse dragging alone. Moving the Tip Radius handle only rotates the shape and increases/decreases the
spoke size. But moving the Base radius handle rotates the “inner circle” previously mentioned, in
addition to altering the spoke size. Since the tip radii are locked in place, this allows you to “twirl” the
shape from the inside out, thus allowing you to produce blade shapes and other intricate designs.

For the first time since the Edit Tool, we come across a Submenu that's extremely useful and well worth a
closer inspection:

Change: [ ]| Polygon Corners:| 5 $| Spoke ratic:ID_3i|:] Rounded:| 0.00C :| Randumized;m_u:l:m :| |-'|:;,ef.au|t5 |
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A) Regular Polygon (with one handle) Instead of a Star
This checkbox completely eliminates the Tip Radius handle,
thus purging any spokes the shape may have and limiting you to
modifying just the Base Radius. In other words, a standard
pentagram like the one we've been using in our examples so far
will be converted into a pentagon.

Despite the radical change in the shape's function, everything that we previously learned about
rotating, rounding and randomizing still applies, so don't think that you have to learn a whole
new set of rules to modify a regular polygon.

B) Number of Corners of a Polygon or Star
This spin button adds either more corners to a regular polygon,
or [more dramatically] adds more spokes to a star.

While you'll rarely have the need to do the former, the latter
option is extremely useful for creating mutli-spoked stars.

C) Base Radius to Tip Radius Ratio
Despite the fancy title, all this spin button does is
increase/decrease the size of the Base Radius (the previously
mentioned “inner circle”).

Since this can be done manually with greater control, there really
is not much use for this function.

D) How Rounded are the Corners
This spin button performs the same function as holding the
SHIFT key, albeit with far greater precision and less risk of
deforming your shape beyond recognition. You should try to
make this your preferred method for rounding your shape.




E) Scatter Randomly the Corners and Angles
This spin button performs the same function as holding the
SHIFT+ALT keys, albeit with far greater precision and less risk of
deforming your shape beyond recognition. Again, you should try
to make this your preferred method for randomizing your shape.

E) Reset Shape Parameters to Defaults
If you don't want to go through the trouble of setting Spoke Ratios, Round values or Randomize
values back to 0, you can always press this button to revert back to a simple star shape.

Once again, in order to turn the star shape into editable Path, you need to click on the Convert Selected
Object to Path button in the Edit Tool Submenu, or press CTRL+SHIFT+C.

While this tool may not be used much for actual character rending, we may use it for certain aspects of
clothing, props, speech bubbles, light effects and background details so it will be worth your time to play
around with this feature. Here are just a few of the millions of different shapes you can produce with the
Star Tool:
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SPIRAL TOOL
Official Descriptor: “Create Spirals”
Keyboard Shortcut: F9

In case the Star Tool seems like a handful, you'll be glad to know that Spiral Tool is remarkably simple to
use,... in fact, the easiest preset-shape maker of all. Since we'll rarely use spirals in Anime renditions, we'll
only take a cursory glance at this tool.

When dragging a new spiral, the SHIFT key is useless and the CTRL key only
locks to key angles (but almost imperceptibly, so this key is basically useless as
well). Both the Inside handle (indicated by the blue arrow) and the Outside
handle (indicated by the purple arrow) modify the length of the spiral revolution.
Both also snap to key angles when you drag while holding the CTRL key. ’

However, with the Outside handle you can use the SHIFT key
to scale and rotate the entire shape., whereas with the Inside

handle you can use the SHIFT+ALT keys to expand or

contract (aka, “diverge” or “converge”) the gap within the

spiral..



Unfortunately the Spiral Tool handles are a bit awkward to use, so it's recommended that you use the
Submenu to modify all parameters.

The Turns spin button serves the dual purpose of increasing the number of spiral revolutions in your shape
while still maintaining the exact size of the shape.

The Divergence spin button does the same thing as SHIFT+ALT, but with far greater precision and
control.

The Inner Radius spin button does the same thing as manually resizing the Inside handle, but again with
greater precision and control.

And in the event the shape has been modified beyond recognition, the Default button is there to return
the shape back to standard spiral.

As always, in order to turn the spiral shape into editable Path, you need to click on the Convert Selected
Object to Path button in the Edit Tool Submenu, or press CTRL+SHIFT+C.

; FREEHAND TOOL
Official Descriptor: “Draw Freehand Lines”

Keyboard Shortcut: F6

Photoshop migrants, or perhaps anyone who owns a tablet, will likely appreciate the only tool that most
closely approximates a standard paintbrush tool. The freehand tool will come in handy if you're already an
experienced sketch artist or if you're drawing something imprecise due to need or efficiency. However, it's
because of this imprecision that we will rarely if ever use this tool during actual Anime cel drawing.

There is no Submenu for the Freehand Tool, and the only key modifier available is the SHIFT key, which
when pressed while dragging will append your new shape to any preexisting Path underneath it. The lines
produced by the Freehand Tool are strokes by default, which you can keep standalone (unconnected) or
close up to form a complete shape. Either way, you can still assign a Path to both open or closed shapes,
although given the context only closed shapes will look the neatest. Also, because it draws strokes by
default, all lines produced by the Freehand Tool are already editable and the nodes can be manipulated
at any time.

Again, feel free to experiment as much as you want with this pseudo freehand drawing method. Much of
the actual free-form drawing in Inkscape will be produced using the Freehand Tool's counterpart, the
Line Tool.

r LINE TOOL
Official Descriptor: “Draw Bezier Curves and Straight Lines”

Keyboard Shortcut: SHIFT+F6

While in theory you could create all the shapes you need by editing the preset shapes described above,
very often it is far more efficient just to sit down and create your own. The Line Tool gives you that very
freedom to draw your own custom shapes just like the freehand tool, but
with the far greater control and precision so endemic in vector graphics.
Though the name suggests otherwise, what the Line Tool essentially
does for you is plot the nodes of an object; the Strokes and or Fill simply
follow along for the ride. Photoshop migrants may find the Line Tool
similar to the polygonal selection tool or even the native vector line tool,
the difference being, in the case of the former, that the Inkscape Line
Tool offers the ability to edit or round out your selection, and in the case

of the latter, that the nodes and handles are larger and more intuitive to {
work with.




The same descriptions posted earlier in the Freehand Tool section about the SHIFT key and about
completion applies just the same with the Line Tool. However, because of the enhanced precision, it
becomes more feasible to complete an open-ended object - this is done by simply clicking on an end node
while the Line Tool is enabled and drawing whatever stroke shape you desire until you connect to the
opposing end node like so:

and

This is good to know in case you end your shape prematurely and still have the Line Tool active -
otherwise, the Edit Tool functions offer a myriad ways to get the same thing done.

While using the Line Tool, you simply point-and-click at each node placement to create unrounded corners
and maintain the lines straight (as shown in the “Before” graphic), or you click-and-drag at each node
placement to automatically invoke bezier handles and curve the lines. This method of producing curves
will have its usage later on - however, its no where near as precise or predictable as applying the Edit
Tool to the shape after its laid on canvas, so it will not be covered as intensively in this tutorial.

With that said, how you can use the Line Tool from here on out is ENTIRELY up to your own imagination.
For example, in a limited time span of a few minutes, you can use the Line Tool to create a rough vector
sketch that can then be smoothed out carefully to create a recognizable character:

First you use the Line Tool to create a rough head shape. Plotting only the key
points is all that's required - while you can round the corners at this time if you
like (we will usually do that when working with heads), at least this method gives
you an idea of how many nodes are required for the character's head (in this case
only 9, and in fact 2 may be dropped during the smoothing phase).

Note that this exercise uses the Fill and Stroke toolbox to alter the stroke width
(as shown here with the eyelashes, which are just really thick flat-ended strokes)
and to give the Fill its skin color. While you're only required to sit and watch at
this point, you can use that toolbox now by going to Object>Fill and Stroke... or
by pressing CTRL+SHIFT+F. The Fill and Stroke toolbox will be discussed in
greater detail later.

Here the Freehand Tool, which is better suited to random and organic shapes,
was actually used to give the tear waterfalls a slight wobble. It's Fill was also
converted to white and the stroke removed. The mouth at this point need only be
a six node rectangle with a slight crease - although if you opt to curve your lines
during the vector-sketch phase, you can create the same frown with only 4 nodes.
The ears is comprised of only 2 nodes, with the last bezier-curved to create a
mound-shape - later we'll add a second bezier curve to finish the ear shape.

Though we will round our heads during the tutorials, hair is a perfect candidate for
point-and-click vector sketching as hair tends to be bristled by default and too
many nodes will interfere with rounding later on. You need only draw each major
strand of hair as a 3 node, open-ended triangle, and then use the Page Up or

E=my Page Down keys to reposition the hair strands above or below neighboring
strands. The 5-node bang above her forehead, for example, is further in front
than all others, and so must not be positioned behind any other hair strand.



Don't worry about leaving the hair in the forefront open-ended, since you will draw
hair in the backdrop that will cover for all the rest. For her hair ribbons, only some
abstract polygonal shapes will do.

Pigtails can also be create with simple 3-node triangular shapes, and then rounded
out later to the proper curvature. However, if the pigtails are required to snake a
little more than usual (such as while turning or when draped over the character's
shoulders), then adding intermediate notes along the pigtail will help. if you need
additional hair strands to streak off the pigtail (or any other hair element), don't
forget to keep the streaks open-ended so that it appears like a natural offshoot of
the pigtails.

Since the pigtails have to be sent behind the head and the base hair, you can just
press the End key while selecting them. This is faster than just pressing Page
Down continuously.

A couple of more pigtails are added, then sent directly to the back using the End
key. The ends of the rear pigtails are bristled a little to save some work later on
(assuming you want bristled ends to begin with.

Now with a little post-production - using the Edit Tool to round
the corners of her head and smooth out the shape of her hair
strands - Lucky Star fans will probably begin to recognize her as
a very rudimentary Kagami Hiiragi.

In fairness, for the sake of brevity, the Line Tool plotting was
done over a preexisting image of Kagami to ensure accuracy
(although the actual post-production was done independently of
the image). However, this same process will be very useful
when creating entirely new characters, and will be revisited later
with greater depth, more step-by-step instructions, and actual
SVG samples for you to study at your leisure.

But as you can see, the Line Tool is the simplest yet most
powerful shape-rendering tool that you'll have the pleasure to
work with. As long as you have the willingness, patience and
imagination to tap this power, the sky is the limit!




p CALLIGRAPHIC TOOL
Official Descriptor: “Draw Calligraphic Lines”

Keyboard Shortcut: CTRL+F6

This is another freehand drawing tool that anyone with a tablet will appreciate. The Calligraphic Tool
emulates (as the name implies) calligraphy pen strokes, and can be used by anyone who wishes to draw
handwriting in their anime renditions. Other than that, it's a bit awkward to use - be it with a tablet or just
a mouse - and offers too little precision to be used to create manual lineart. Future versions of Inkscape
plan to clean-up this tool, and make it desirable and practical to work with. Till then, you're free to try this
out on your own, but it will not be used or supported much in the main tutorials.

Drawing with the Calligraphic Tool works just the same as the Freehand
Tool, with the exception that you're drawing Fills rather than Strokes. As
you change direction, the Fill will also change in width and angle just like
real pen strokes.

The SHIFT, CTRL and ALT keys are completely useless with the
Calligraphic Tool, and since these are Fills beings drawn, there will
likely be too many nodes to edit the final lines easily. The only keys that
may be of any use to you while you're drawing are the Left/Right keys,
which adjust the stroke width, and the the Up/Down keys which adjust
the angle.

The Submenu also provides spin buttons to regulate width and angle, as well as extra filters to simulate
such things as “wiggle” and “pen mass”. However, these are all preemptive adjustments that will take
effect next time you draw. Furthermore, because these are Fills rather than Strokes, any overlapping
shapes will result in blank spaces (as seen in the intersection in the above example). This is because in
Inkscape, intersecting sections of the same Fill are interpreted as reverse fields, hence the reason why
they seem to disappear once the final shape is rendered. Try drawing a coiled line or a word written in
shorthand, and you'll see what this means in action, and why this also lessens the value of this tool for the
more important aspects of Anime cel artwork.

TEXT TOOL
Official Descriptor: “Create and Edit Text Objects”

Keyboard Shortcut: F8

A fairly self-explanatory tool, the Text Tool allows you to input text on your canvas. This tool is virtually
identical to text tools found in raster graphics programs such as Photoshop, right down to the fact that the
text letters cannot be directly manipulated without the ubiquitous Edit Tool conversion.

Operation of the Text Tool is very simple: you simply point and L
click anywhere on the canvas to begin typing, or you click and H ]I W [ '
drag a bounding box to constrain your text within a specific area. | e 0 O r .
The act of typing your letters is as easy as,... typing on your — o
keyboard!

There are no fancy shortcut keys or mouse movements associated with this tool. The Submenu is not all
that different from the generic text toolbars found in most office suites such as Microsoft Office or
OpenOffice, but we'll briefly review it for the sake of being thorough...
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A) Font

Select from any of your system fonts here. A small preview of the font will be made available
besides each font name for your convenience.



B) Font Size
C) Align Left
D) Alight Center
E) Align Right
F) Justify
G) Bold
H) Italicize
1) Horizontal Text
J) Vertical Text
This last one may be useful if you want to input Top-Down Japanese text.

In the event you need to edit a text block, just click (with the Text Tool selected) directly over existing
test. Otherwise, clicking elsewhere will just invoke another text block. Note, however, that once you
convert the text into Paths with editable nodes, you will no longer be able to add or remove letters using
the Text Tool.

CONNECTOR TOOL
Official Descriptor: “Create Connectors”

Keyboard Shortcut: CTRL+F2

Surely someone with boatloads of creativity can find a good use for the Connector Tool as far as Anime
cel drawings go. Otherwise, it stands as a tool probably meant to give Inkscape pseudo-flow chart
functionality as Visio, Kivio or Dia, but was never quite completed.

Basically, the Connector Tool allows you to create an A-to-B line that “sticks” to any two objects, as long

as the ends of the line are connected to white squares that appear at the epicenter of each object. Once
connected, regardless of where you move the objects, the connections will always link the two together.

to

That's basically the gist of this tool. It's Submenu has additional functions that allow you to play around
with the connections (such as making them avoid any objects in their path, but since this tool is not
particularly relevant to our tutorials, you will have to experiment with this tool on your own if you're
interested.

GRADIENT TOOL
Official Descriptor: “Create and Edit Gradients”
Keyboard Shortcut: CTRL+F1

Until the advent of version 0.46, the Gradient Tool is the
closest thing you will get to a paintbucket tool in Inkscape. The
concept is very simple: select any Path (its Fill, by default),
and then click and drag from one point to another to create a
gradient. Users of Photoshop's on gradient tool may feel right
at home with this tool, with the exception that the gradient is
constrained only to that particular Fill (or Stroke, as we'll see
in a bit), thus making the results a lot more predictable.




An additional benefit is that the gradient direction can be readjusted in real-time, by manipulating any of
the gradient line's handles. Therefore, if the gradient came out incorrectly, you can go back and edit it any
time time (like almost everything else in Inkscape).

The Gradient Tool does have some angle snapping and symmetrical gradient line expansion tools that
can be invoked with the usual assortment of keyboard shortcuts, but given the simplicity of this tool (which
actually benefits from manual dragging of the handles) and the rarity with which we'll use it (because
there are other methods with which to create gradients), they will not be covered in detail.

Similarly, the Submenu above has various options with which you can switch from linear to radial
gradients, switch from modifying Strokes instead of Paths, cycle through existing gradient profiles, and
edit the gradient colors. However, once again we'll leave this aside for now, since the topic will be
revisited again (in greater detail) during the Fill and Stroke Toolbox section in Chapter 2.

COLOR PICKER TOOL
Official Descriptor: “Pick Averaged Colors from Image”

Keyboard Shortcut: CTRL+F7

And finally, what drawing program would be complete without the trusty color picker? Actually, there is a
good reason why it says in the descriptor “Averaged Colors”. Don't forget that there are no pixels in vector
graphics, so unlike raster graphics tool you can't simply have your color picker choose the color of the pixel
it's over (assuming you had it in pixel selection mode). Therefore, the color picker works best when you
click and drag slightly over the area you want to acquire the color from.

By default, the Color Picker Tool works as follows: you first select the object you want to change the
color of, you then select the tool, and THEN you click (or click+drag over the color you want to transform
the selected Fill to). Similarly, you can hold SHIFT while clicking to change the color of the selected
object's Stroke rather than Fill.

However, as we advance in the tutorials, we'll discover more efficient ways of performing these actions, so
we'll leave it at that as far as this tool is concerned.



CHAPTER 2:
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COMMANDS BAR
Description: Generic program management menu.

Admittedly, this chapter may be something of a waste of time, given that the toolbars described are fairly
self-explanatory or deal with components that will be discussed in greater detail later on. But for the sake
of completeness, will go over these in brief.

The Commands Bar is not unlike the main toolbar of every single application known to modern operating
systems and can be broken down as follows:
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A) Create New Document From the Default Template

B)

C)

D)

E)

F)

G)

H)

This buttons opens up another new Inkscape canvas.

The keyboard shortcut CTRL+N performs the same function.

Open an Existing Document

This buttons opens up your file manager and allows you to open an existing file, or import a
compatible raster or vector graphics file onto a new canvas. In the Select File to Open
window, look at the dropdown box that reads “All Images” for a list of compatible vector and
raster graphic formats (suffice to say, the list is exhaustive and destined to be even bigger).

The keyboard shortcut CTRL+0 performs the same function.

Save Document

Saves your current canvas to its designated SVG file, or prompts you to create a new SVG file if
you haven't already. Please save frequently. Stability has improved significantly since version
0.45, and if you're lucky then your unsaved file can still be [randomly] dumped into a temporary
SVG file during a program crash. Nonetheless, Inkscape is still in development and CAN STILL
CRASH, so save frequently to avoid any regrets (and to practice good computer hygiene).

The keyboard shortcut CTRL+S performs the same function.

Print Document

Sends whatever is on the page directly to your printer (File>Print... may be more desirable).
The keyboard shortcut CTRL+P performs the same function.

Import a Bitmap or an SVG File Into this Document

Does the same thing as B) above, except the SVG file or other raster/vector image are imported
directly on your canvas rather than in a new window.

The keyboard shortcut CTRL+1 performs the same function.

Export This Document or Selection as a Bitmap Image

This button opens up the Export Window, which will be discussed in greater detail during the
tutorials when we start exporting your masterful creations into PNG files.

The keyboard shortcut SHIFT+CTRL+E performs the same function.

Undo the Last Action

This is a graphical button you can use to Undo, although it's advisable that you get used to the
keyboard shortcut CTRL+Z, not just in Inkscape but in ALL programs that support the Undo
action. Using the keyboard is far more effective in this respect.

Do Again the Last Undone Action

This is the reverse of F) above (aka Redo). However, since you'll rarely be using this as much
as Undo, there's no need to get used to it's more long-winded shortcut of SHIFT+CTRL+Z.
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K)

L)

M)

N)

Copy Selection to Clipboard

Again, more power to you if you become more familiar with CTRL+C rather than it's graphical
equivalent whenever you copy a selected object.

Cut Selection to Clipboard

Use CTRL+X instead, even if you won't find yourself using Cut as much as Copy.

Paste Objects from Clipboard to Mouse Point, or Paste Text

Use CTRL+V instead whenever you do any kind of pasting. However, please note that, unlike
some raster programs or office suites, you can't paste images from external sources into
Inkscape [you can only import bitmaps using D) above]. Similarly, the “Paste Text” aspect only
pertains to when you're using the Text Tool -- otherwise, it will have no effect.

Zoom to Fit Selection in Window

Does what it advertises. Don't forget that you need to select an object first before using this
button. Likewise, you can also press the 3 button on your keyboard to zoom in this manner.
Please note as well that this icon is also present in the Submenu for the Zoom Tool.

Zoom to Fit Drawing in Window

Does exactly as K) above, except for the entire drawing rather than just a selection from it.
Press the 4 button on your keyboard to zoom in this manner.

Please note as well that this icon is also present in the Submenu for the Zoom Tool.

Zoom to Fit Page in Window

Does exactly as K) and L) above, except for the entire page dimension as specified in the
Document Properties (more on this later). Press the 5 button on your keyboard to zoom in
this manner.

Please note as well that this icon is also present in the Submenu for the Zoom Tool.

That about covers all the generic functions. Now for some more Inkscape-specific properties:

0)

P)

Q)

R)

Duplicate Selected Objects

Duplicating an object is one of the most useful functions
you'll encounter in Inkscape, so you would do well to get
used to the CTRL+D keyboard shortcut so that duplicating
an object becomes as second-hand as copying. Note that
the object duplicated will appear directly over your selected
object, so simply move it out of the way to reveal the

original object.

Create a Clone of Selected Objects

The keyboard shortcut for cloning an object is ALT+D.
However, cloning is not the same as duplicating an object,
and therefore may not be used as much.

Whereas duplicating creates a standalone object, cloning
creates a “slave” to the original object and inherits every
single change to the original (including changes to its size,
color, stroke width, and node placement) EXCEPT placement. How desirable this may be
depends purely on circumstance, although since the Clone can be resized or rotated to a
different position and still inherit the original's changes, this may be useful in creating abundant
patterns that require a high degree of differentiation (such as a mountain range or spikes).

Cut the Selected Clone's Link to it's Original

The keyboard shortcut for cloning an object is SHIFT+ALT
+D, but again this function is far too rare to warrant
memorization for that. Proceed with caution, as breaking a
clone's link to its original is an irreversible process.

Group Selected Objects

Grouping can be a very useful function when dealing with
highly complicated shapes that need to be moved around a
lot (such as jewel-encrusted crowns or earrings). What this
does is turn a lot of separate objects into one giant [but
temporary] super object that can be resized, repositioned,
rotated, skewed, or color-changed in perfect unison.




S)

T)

The keyboard shortcut is CTRL+G and more power to you if you can memorize this swift

keystroke.

Note also that you can still edit individual shapes within the Group if you select

them first using the Edit Tool, and then using the Selection Tool if desired. Just be careful when
trying to Rotate them using the simple double-clicking method, as this reselects the entire
group (keep the CTRL key pressed when you conjure up the Rotate handles in order to avoid

this).

Ungroup Selected Objects

Does the exact reverse as the previous function, and
breaks up a Group. This is why it was stated that Groups
are only temporary unions between different objects, as
there does exist ways to make this union permanent
(more on this later).

Feel free to memorize the SHIFT+CTRL+G keyboard
shortcut, as you may need to use this regularly if you
Group often.

Edit Objects' Style, Such as Color or Stroke Width

This button summons the Fill and Stroke dialog window - if the
Inkscape Toolbox can be considered the backbone of Inkscape, than the
Fill and Stroke windows is it's central nervous system. Because
Inkscape uses the free windowed approach to its dialog boxes the same
way GIMP does (unlike Photoshop or Krita, which embed their dialogs
directly into th main window), learning the SHIFT+CTRL+F keystroke
is not only invaluable, but it's recommended that you do so every time
you open Inkscape in order to keep it always available. Keeping all
dialog windows on top is still experimental as of this writing, but
Beryl/Compiz Fusion users can do so externally by pressing the “Set”
button in the dialog's titlebar (assuming the theme being used supports
the “Set” function).
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The entirety of Chapter 3 will be devoted exclusively to this dialog window, so don't worry about
learning anything else about this tool (that is, unless rightful curiosity gets the better of you).

U) View and Select Font Family, Font Size and Other Text
Properties
A dialog window of far lesser importance, if only because the
Text Tool's Submenu contains the exact same variables to
modify without the need to memorize the SHIFT+CTRL+T
keyboard shortcut. Use this dialog window only if you want a
more convenient method to preview various text fonts.
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V)

View and Edit the XML Tree of this Document
For very advanced users who have knowledge of XML and do not
fear diving into the guts of what makes their SVG file tick.

The SHIFT+CTRL+X keyboard shortcut will bring up this XML
Editor as well.

Click to select nodes, drag to rearrange.

W) Align and Distribute Objects

A semi-useful dialog window which can evenly align objects in a selection,
distribute them equally, randomize their positions, clump them, unclump
them, etc. The Align and Distribute dialog window may not be used very
much, but will still get its own small chapter later on, if only because it
assists with precision work (such as floor plans) and documentation (such
as flow charts), and thus may prove invaluable for work and school (or

anime renditions of such things).

The SHIFT+CTRL+A keyboard shortcut will bring up this Align and

Distribute dialog window as well.
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X) Edit Global Inkscape Preferences

This is just a more convenient method of accessing the P —

Inkscape Preferences menu, although instinct may ol IR —

drive you to accessing this from File>Inkscape oy ||| @ oD as <nage>

Preferences... instead. Usually the way Inkscape m e e

operates by default is good enough for most tasks, but Connector smplifcaion trestold: (00120 |2

if you prefer to modify a few things (such as forcing the s Gommmnulabilmos (20

Line Tool to remember the last style employed), then | 5, “mtess | oo

this dialog window will be very useful to you. Cevans ||| Do st ot e s
Misc

The SHIFT+CTRL+P keyboard shortcut will bring up
Inkscape Preferences menu as well. Furthermore, double-clicking on any icon in the
Inkscape Toolbox will not only open the Inkscape Preferences menu, but will also open
straight into the section dealing with that very icon! This is therefore the most convenient
method of opening this dialog window.

Y) Edit Properties of this Document

Finally, we come to the more convenient method of accessing — [FERSEESEE e S —CES
File>Document Properties... Though this may seem like a |cenera

mundane menu to use, it actually provides a wealth of options e ms 2]
that you should be aware that can enhance productivity. The i —

Format

Document Properties menu, for example, allows you to display a m 210.0 % 207.0 mm
grid on your canvas, or make your objects snap to a guideline if Page size; US Letter 85x1L0in

US Legal 8.5x 14.0in

need be. It also establishes the background color and alpha PP c

Page orientation: @ Portrait © Landscape

layer of your document, in case it's not in your best interest to na
export your images with a transparent background (which usually width: [744.08 [ px ¢
results in a plethora of “jaggies”)' Height: |1052.36 [2] [Fit page to selection |

Border
Show page border

The SHIFT+CTRL+D keyboard shortcut will bring up Document O Border on top of drawing
Properties menu as well. Note that because of the importance e @ e—
of this menu, a chapter will be dedicated to using and dissecting -

everyone of its features.

PALETTE BAR
Description: Generic color palette swatch

You might be thinking why it's even necessary to spend time explaining the Palette Bar, which is another
iconic feature of most run of the mill paint and image editing programs. Moreover, you may find yourself
doing color selections using the Fill and Stroke window (discussed later) instead. Nevertheless, one can
never underestimate the little nuances found in each and every Inkscape tool, and as we take a closer look
at the Palette Bar, you may be sufficiently impressed to keep it mind whenever you need to make a quick
and easy color selection.

The default Palette Bar opens up with the “Inkscape Default” color palette (shown above in the section
title) - though only grays, basic solid colors and reds are immediately visible, you can discover the rest of
the palette by moving the bottom horizontal scrollbar over to the right (not to be confused with the upper
horizontal scrollbar, which manages your canvas). When you have an object selected, clicking on a color
box in the palette will change the object's Fill to that color selection. If on the other hand you need to
change the object's Stroke color, then hold the SHIFT key while clicking on the palette. Incidentally, if
you have no object selected, your color selections will be saved until you create a new object - in fact, if
you have a preset object tool selected (e.g., the Rectangle Tool), you can see your Fill and Stroke color
selections in the rightmost side of its Submenu.

New: Rx:[0.00C|2| Ry:[0.00c/2] lpx 2 ,

The “F."” stands for “Fill” and “S” stands for “Stroke”. The number beside the Stroke color represents the
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stroke width, although this will be revisited later.

Note that you can also drag and drop “colors” from the Palette Bar onto your object (they will appear like
tiny squares attached to your mouse with the color you selected). This is a very impractical method of
choosing a color for you Fill or Stroke, but it is useful in case you want to see how well your desired color
matches with its surroundings. Note that the SHIFT key applies to this drag-and-drop method as well, in

case you need the Stroke to be modified.
At the end of the Palette Bar is an inconspicuous little arrow that 8";'

when selected displays the Palette Swatch Menu. The Swatch e B <
Menu is a powerful feature that helps modify the palette swatch to
your liking, short of allowing you to add your [>]

iy own palette (not yet implemented, although this will likely be the case in future non-
development versions of Inkscape). The Palette Swatch Menu is broken out between
Olarge three sections, mainly Size, Wrap and Palette Selection.

Ohuge

Owrap The Size portion offers 5 preset sizes (Tiny, Small, Medium, Large, and Huge), which
OReds modify the size of the color boxes inside the palette. For most purposes, the default
'ff:"ebHel* Thome Palett size of “Small” is good enough, although “Tiny” may be preferable if you wish to wrap
v SN TEMETEERE your color palette (more on this coming up next). “Huge” is generally too unwieldy to
© Inkscape default use unless you need to magnify the palette swatch in order to better appreciate the
Gold subtle differences between adjacent colors.

The Wrap portion consists of a single checkbox which enables or disables the wrapping of the Palette Bar.
This is generally disabled by default, but if you prefer to select your color from the Palette Bar, it's
advised that you enable wrapping in order to make every available color accessible to you. However, note
that the wrapping only increases the size of the Palette Bar just enough to cover 3 “Tiny” rows (which are
equivalent to one “Huge” row). Any colors that cannot fit within this 3-row “limit” will simply be carried
over over into the non-visible section, accessible only by the horizontal scrollbar (and thus somewhat
defeating the purpose of wrapping). This is why it's preferred to keep the palette swatch size at “Tiny”.

I {#2C5AA0¢ ] B

Finally, the Palette Selection portion allows you to cycle through preset color palettes (though you can't
add your own yet outside of using development files. The average user may find the Inkscape Default
palette more than necessary - in fact, the Fill and Stroke window color selections will probably be more
than enough as it is. However, color specialists may appreciate the ability to compare and contrast
between specific color gamuts, topographic values or web-safe entries. Here are the alternative preset
color palettes available at the time of this writing:

Reds
WebHex

Tango Icon Theme

Greens

Gold

Windows icons

Hilite

Gray
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STATUS BAR
Description: Information and Shortcut Bar

This bar may seem like a redundancy since most of its features can be accessed from other menus. As
with all the toolbars previously mentioned, you can always disable it in case monitor space is a premium
for you and you don't find it particularly useful. Nevertheless, the Status Bar provides a convenient focal
point for all editing activities, and certain features like the Description Tool are invaluable for beginners
who may not remember all the Toolbox keyboard shortcuts.

2:__40:"96 2| @ @ |-Layer1 2z |Ellipse in layer Layer 1. Click selection to toggle scale/rotation handles. izigg'ggz:f 1409[2]
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A) Fill and Stroke Colors
You may remember this from the last section, where the Fill and Stroke color selection is
shown to be visible in most Submenus. This is the exact same thing, although the placement
is much more permanent. The larger color slab with the “F” once again designates the Fill
color, whereas the smaller one by the “S” represents the Stroke. Double-clicking on any of
these color slabs will invoke the Fill and Stroke Window (which will be discussed in the next
chapter). Note that hovering your mouse over any of the two colors will give you its
hexadecimal value (although this is easier to obtain from the Fill and Stroke Window).

B) Stroke Width
The number beside the Stroke color represents the width of the selected Stroke. This is
mainly for reference as you cannot alter this number here - double-clicking will simply open up
the Fill and Stroke Window on the Stroke Style tab (which again, will be discussed later).

C) Master Opacity
The spin button beside the conveniently-placed “O” represents the opacity of the Path selected.
This is the master opacity (it alters BOTH the Fill and Stroke, hence the Path), so if you need
to alter the opacities of the Fill and Stroke independently, you will need to use the Fill and
Stroke Window. On the other hand, the master opacity can be altered from the Status Bar, so
this is good to know in case you need to add some quick transparency effect.

D) Toggle Current Layer Visibility
This is the first of three Layer management tools available in the Status Bar. Clicking on the
eye will either hide the Layer shown in the Layer Toggle, or display it in case it's hidden. This
offers far less precision than the Photoshop-like Layer Window, but at least it's convenient.

E) Lock or Unlock Current Layer
This tool will lock or unlock whatever Layer is currently displayed in the Layer Toggle.

F) Layer Toggle
Here you can select which Layer you want active [in order to manipulate with C) and D) above,
for example]. The Layer name also changes depending on which object you select, thus
making it indispensable if you quickly need to know where it's located. This is even more useful
when said object is trapped in the mysterious (root) layer, inaccessible from the Layer
Window.



G)

H)

Description

Perhaps the most useful Status Bar feature, this section will display a description and shortcut
information of whatever object, tool or handle you have selected. While you're learning how to
use Inkscape, it's very useful to keep an eye out for any useful tips and reminders that may
appear.

Cursor Coordinates

As can be inferred from the letters, this section provides the real-time X,Y [width and height]
coordinates of your mouse cursor. Very useful for precision work (especially when the Grid is
enabled).

Zoom

As you can tell from the “Z” and the percentage sign, this spin button is yet another way to
control the Zoom factor of your canvas. Changing the Zoom factor here is a bit awkward, as
the placement is too far removed to make it better than using the simple + and - keys.
However, it is the only permanent spot where you can view the actual Zoom percentage - for
example, you can set it to 100% and work with real-world units (in conjunction with the Grid
and Ruler, for added precision).
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Up until now we've focused primarily on creating new shapes in Inkscape. However, in any art program,
it's equally important to color or texturize a drawing as it is to draw or sketch it. While the Color Palette
provides a quick and dirty means to change the color of a Fill or Stroke, it pales in comparison to the
wealth of options available through the Fill & Stroke Window. If the Edit Tool and Line Tool represent
the “bread and butter” of Inkscape, then the Fill & Stroke Window represents the sweet fine marmalade
that helps make the entire meal a pleasure to eat. So too will you find Inkscape a pleasure to work with
once you're finished with this chapter.

Just as a reference, you can summon the Fill & Stroke Window via the following options:

SHIFT+CTRL+F keyboard shortcut.

The Edit Object's Style icon found in the Inkscape Commands Bar.
Double-clicking on the Fill and Stroke color panels in the Status Bar.
Accessing it from the Inkscape File Menu, via Objects>Fill and Stroke...

] Fill | Fill Paint Tab
= Description: Various tools to modify an object's Fill color.

Colored lines are not uncommon - however for the most part, when you think of
coloring a drawing, it's far more likely that you're thinking of adding color to
those often wide blank expenses between lineart. If you've ever indulged
yourself in coloring books in your youth, you'll recall that all the lineart was
done for you, and your job was to simply add color in the spaces using crayons
or colored pencils.

If this is what you're used to, then you needn't veer too far off from your
established paradigm - other than that rather than using a virtual paintbrush or
paint bucket to apply color, you use the Fill Tab to assign a color, gradient or
pattern within the boundaries of your Path. Oh, and of course, you can
reassign and replace as many colors, gradients or patterns as you wish,
something which is not entirely lossless in a raster graphics program, and
virtually impossible in a coloring book!

When you select any portion of the living Bomblet above, you will see that the Fill & Stroke Window
mini-toolbar will look like this:

xXpoom 2

The No Paint icon is selected. What this means is that no Path exists - the
space within the Strokes is completely transparent. Don't let the white fool you
- you're simply looking at the raw lineart, and this paper (as well as the default
Inkscape canvas) just happens to be white. This may not be immediately
obvious until you try changing the background color of the canvas (via the
Document Properties, described later).

Definitely lineart, no? Some comic panels and manga would probably end here,
and there will definitely be situations where no Fill is desirable. However, since
we want a color drawing, and since it's so easy to work with color in Inkscape,
why don't we go ahead and add some?




Select the large round circle of the Bomblet, and select Flat Color icon in the mini-toolbar:
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Immediately, a plain flat color will fill the space within the circle boundaries -
the color being either a random one, whatever was previously used, or
something you preselected beforehand via the Color Palette. As you can see
in the example, the Bomblet is turned a pale green. Note that while the eyes
seem to be colored green as well, this is only because they're Paths are
positioned directly above the larger circle AND intentionally overlap with it. The
left leg is also positioned above the circle, but in order to keep the lineart clean,
it was not allowed to overlap with it. Instead, the leg literally cuts into the
circle - something you'll rarely have to do in actual production, since a good Fill
can mask the intersecting lines.

Course, whoever heard of a green bomb? We can easily fix that, but how do we do that?

Inkscape gives you four thorough methods to select or modify your color selection:

Red, Green and Blue Mixing Hue, Saturation and Lightness Levels
'RGB|HSL CMYK Wheel RGB| HSL|CMYK Wheel

R eas T ==
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Cyan, Magenta, Yellow and Key Mixing Color Wheel

RGB HSL CMYK |Wheel RGB HSL CMYK Wheel |
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RGB reproduces a color by mixing the spectrum of Red, Green and Blue, the three primary colors that form
the foundation for the most widely used color model in all computer and video applications. All three
mixing values auto-update in real-time, hence the reason why you do not actually see red, green and blue
colors (you can if you choose pure black). This, plus the ability to enter your colors numerically via the
adjacent text and spin buttons, makes this a useful function for color professional. New users, however,
may find this a bity tricky.

HSL reproduces a color by manipulating the three main attributes of perceived color - mainly its pure color
(Hue), its vividness/intensity (Saturation), and its color space brightness (Lightness). This is similar to the
Hue/Saturation tool in Photoshop, albeit with real-time updates to the color selection, given that we're only
manipulating a single color rather than an entire complicated image.

CMYK reproduces a color by mixing the spectrum of Cyan, Magenta, Yellow and Black (or “Key”), the four
process colors that make up this subtractive color model (select pure white, and you will see all the values
in their native form). This functions exactly the same as with the RGB selection, only with greater
complexity. Anyone experienced with photo, color document and poster printing, however, may know



exactly what all this means, and may appreciate the ability to color select using these values.

Wheel allows you to choose a color from a Hue and Saturation color wheel (the Hue is the outer ring, the
Saturation is the compass-like triangle). You make your selection by choosing a slab of the Hue ring, and
any point within the Saturation triangle. This offers the most intuitive way to alter color-selection choices
real-time, and is the most highly recommended for beginners.

In addition to color, notice that all these (including the Wheel) have a slider that begins with “A:”. This
stands for “Alpha” or the transparency of your color - manipulate the value (either directly on the slider or
via the text box/spin button) to make your color transparent (or “see-through”).

And finally, notice as well that underneath all these color selection tools you have a field box labeled
“RGBA:” featuring the hexadecimal value of your color:

RGBA:|979797f |

In the event you're well-versed in the art of entering color values using hexadecimal code, you'll find this
manual input field to be very useful. However, even non-technical users may find this useful at times
whenever an EXACT color value needs to be extracted whenever the Color Picker Tool is too imprecise
for the job. Simply copy this text string from the desired color and paste it into the RGBA value from the
Fill you want changed.

As you can see, all these methods get the job done. It's really only a matter of choosing which one fits
your level of comfort and/or expertise.

Let's go ahead and add some more realistic flat color to the Bomblet. Flat
coloring is the process of applying a uniform color over a path(s), without
applying any sort of shading, highlighting, gradients or texture. The result is a
very bright, “cartoonish” look - not surprisingly, a lot of early animation used
flat coloring in order to make it easier to animate characters (something which
was and is still slightly more difficult to perform when dynamic shading and
lighting is involved). Select each component of the Bomblet using the
Selection Tool, press the Flat Color icon in the mini toolbar, then proced to
pick out appropriate colors using the Wheel (for example). Leave the Alpha
value at maximum so that there's no transparency. If all goes well, you should
end up with something similar to the image on the right.

Hopefully now it's starting to look like something interesting. Being a very minor, inanimate object
character, beanie eyes work very well with him (and are as easy to draw as it is to squash a circle shape).
The legs are given a human tone to contrast with all that grayscale - notice that while there is now shading
applied to the Bomblet, his right leg is given a slightly darker hue to implement a kind of pseudo-shading
effect. The sizzling spark has its main color in the outer ring (orange), and a brighter color within (near-
white) - this is a good way to enhance the appearance of a bright object, although in this case the spark is
FAR from looking realistic.

While this “flat” look can work with cartoons and is perfectly acceptable for comedies, from an artistic
point of view the image looks rather boring. While this can be remedied by using additional flat coloring in
a creative manner (e.qg., “Flat shading”), we'll briefly explore other methods in Inkscape with which you can
add additional depth and realism to your drawings.

Click on the large circle again, and on the mini-toolbar select the Linear Gradient icon shown here:
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Wow! The Bomblet's body turned blue now! Or did it?

In fact, the body is now colored with a gradient rather than a flat gray color.
The reason why it has some blue is because a new gradient always defaults to
the following prerequisites:




A) The gradient starts off with only two color stops.

B) The first color stop uses whatever flat color was previously used on the shape. Since in this
case gray was used, the exact same gray is used here and you will see traces of it on the left.

If no color exacts prior, a random one is assigned.

C) The second color stop is also the same as the first; however, the Alpha level is set to 0, hence

full transparency.

So there you have it.... the Bomblet is blue because half of him is see-through!

Sometimes the effect is

desirable, but in this case we'll be looking for something a bit more substantial.
First off, notice that the Linear Gradient has a wildly-different menu than the Flat Color one:

The dropdown that reads selection “linearGradient3159”
is where all gradients used in your canvas are stored.
Currently, there is only that one - however, as you
beginning using more (and different) gradients in your
image, these will begin accumulating here. Even if a
gradient is being used by another Fill, that doesn't matter
- all you're Fills and Strokes can reuse the same
gradient ad infinitum.

The preview window beside each label will allow you to
see what the gradient looks like - so if you want to switch
from this gray half-transparent gradient to a nice orange
one you might have created earlier, all you need to do is
select from the dropdown as shown on the right. Notice
that this orange gradient has no checkered pattern, which
means there is no transparency. We'll discuss how to
create or modify a gradient momentarily.

Linear gradient
| linearGradient3159 [

|
Edit... |
¢ |

Repeat: | none

| Duplicate l

Linear gradient

linearGradient3167 |

|
linearGradient3159 ESEREE: g |
|

<»

<

Repeat: | none

The Duplicate button allows you to create an exact duplicate of the current gradient you have selected in
the drop-down. This may seem redundant, as you can reuse the same gradient for as many Paths as you

want.

However, this helps as a good starting point for when creating gradients that are similar to a

preexisting one. OR you may use it to experiment with changes you want to make to a gradient without

ruining ones already in use on the canvas.
automatically affect those already in use in your image.

The Edit... button summons the Gradient Edit window, which is an entirely new

and exciting window in and of itself!

At the very top is a long preview of the linear gradient, in this case flat gray plus

transparent gray only.

WSS Underneath it is the Stop dropdown, which functions | 9™ &
[ stop3161 | [z the same way as the previous dropdown, except it Stop Color
%0 stop3163 | “! only shows single colors. Notice that the transparent RGB HSL CMYK|Wheel

ATOStopTDelete stop |

Underneath it we have the Add Stop button and the Delete Stop button. One
of course adds Stops, the other takes them away. Since you can't have less than
two Stops to make a gradient, the Delete Stop won't work in this instance;
however, let's go ahead and add a stop to break all that gray!

one has a checkered pattern next to a solid gray
square. As you can imagine, one side represents the
Alpha tranparency level, the other the color itself.

Bear in mind that any edit you make to a gradient will

R

(1 | stop3161 ¢/

| Add stop || Delete stop |
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RGBA:|979797ff

stop3161 [eieiis | The stop is added above whichever gradient you currently have selected, so be

5 stop3173 ] =
=0 stop3163

. | Button
ROTsTopTTDelete stop |

sure to select “stop3163” (in this example) first.
- the color inserted between the solid and transparent grays
(“stop3173) will default to something that's an intermediate of the two.

Then click on the Add



Notice that right below is another color Wheel, as well as the standard B

assortment of RGB, HSL and CMYK color selection tools. These too can be T

used to select a color for your new Stop. Since it's already on

stop3173 2|

vibrant red as well as the maximum Alpha value. You should

being edited, by the way, notice that the Bomblet's color also
changes in realtime.

the red spectrum (in this example), go ahead and choose a || Addstop || Delete stop |
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end up with the gradient shown on the right. As all this is Offset:

T - AR |

Finally, notice the Offset spinner in the center of the Gradient Window. This is used to indicate where
your stop is positioned along the gradient.

1 - b N \\ "
That it's currently set at 50 means that the red color Stop is | —m  COEET m
located PRECISELY in the middle of the gradient. If you were to \J
change this number to 80, then it would skew further to the .' |EEEEE  stop3173 ¢

right as shown.

Especially when working with polished metal
finishes, atmospheric effects, or specialized color gradients, the

ll| Add stop [ Delete stop |

ability to offset their placement will come in very handy. Offset: =)

In any event, let's stick to a simple linear gradient for our example....

Select the last Stop from the dropdown and press the Delete Stop button. The first
Stop should still be a gray color, so change the red color Stop to a white color. The
end result will be a monochromatic gradient that seems to be lit closer towards the

spark's light source. The overall effect makes more logical
sense, but perhaps the gradient is just a bit too light?

In that case, close the Gradient Window and select the Edit Tool. If you remember
the excerpt about the Gradient Tool, you'll immediately recognize the gradient
handle. With this handle, you can manipulate where the gradient begins and ends.
Click on the handle node to the left and drag it towards the middle of the Bomblet.
You'll end up with a greater concentration of gray versus white, making the lighting
effect just a little more natural (at least for a bomb).

The linear gradient may give the Bomblet a slightly greater level of realism, but it's still somewhat flat and
unnatural. We'll fix that up with a Radial Gradient, but before we proceed, let's take advantage of our
slightly offset gradient to explain this easily overlooked feature of the Linear Gradient menu:

Repeat: | none

b |
e

The Repeat dropdown menu controls the behavior of your gradient past the gradient handle nodes. As it
is currently selected at “None”, the Linear Gradient does nothing more than repeat the first and last Stop

colors indefinitely. This is why moving the Gradient Tool handle in the previous
example created more gray space - it was simply repeating the last color in the
gradient. No doubt had this been done in reverse (with the white handle), you
would get mostly white space.

However, select “Reflected” from the dropdown menu and you'll end up with the
image on the right. As the name implies, the gradient is made to “reflect” (or print
in reverse) its pattern after the first and last nodes. While this same dual-reflected
look can be imitated (perhaps more precisely) using a 3-Stop Linear Gradient, using
the Reflected Tool can be faster and more efficient.

Selecting “Direct” from the dropdown menu does essentially the same thing.
However, as you can see from the image on the left, it will not reflect/reverse the
linear gradient, but simply keeps repeating the gradient itself indefinitely. As you can
see, this effect is very undesirable for our Bomblet - but just because it doesn't work
here doesn't mean there's no use for a Direct Repeat. Think about how quickly you
can draw up some conveyor rollers or a bamboo wall, using a truncated Linear



Gradient with a Direct Repeat.

Now that we're done playing with Repeats, reselect “None” and let's move on...

Click on the large circle again, and on the mini-toolbar select the Radial Gradient icon shown here:

x@OOmE 2

Now rather than the gradient flowing from left to right, it now flows from the a center point outward! This
is a very useful gradient for when you want to illustrate spotlights, light reflection, and fast-rendering
“haze” effects (that do not require the Blur function).
However, right off the bat, we have a small problem:

Since the gradient now works from the center, outward, it will use the first color to represent the center
color, and there will be no way to change that using the handles. This means you will need to go back into
the Gradient Window to switch the white and the gray around. Once you do, it should look like this:

Much better!

Now it's starting to look like a bomb! Granted the cast iron surface of these kind of old-

fashioned balls may warrant a tighter highlight, it still beats the flatter-looking Linear Gradient previously

used.

The center focal point always defaults (as you can imagine) in the center of the
object, but don't feel that you're limited to this placement. Notice that when
selecting the circle with the Edit Tool, an XY set of handles will appear. Use the
Y [vertical]l] handle to control the “height” of the white highlight or the X
[horizontal] handle to control the width of the handle - a flatter look as shown to
the right might be more appropriate for the highlight. You can also move both
handles, either freely or holding the CTRL key to snap it
to angles, in order to control the angle of your highlight
(which is very important now, since an angled position
helps with the curvilinear appearance.

Likewise, you can also move the center point itself by dragging the third handle
intersecting the XY handle planes. Drag it over to the right side of the bomb so
that the highlight more appropriately represents the reflection of the spark, as
shown in the picture on the left. Knowing these techniques should put you on
your way towards making interesting lighting effects.



But wait, there's still one more neat thing you can do with the Radial Gradient
handles! When you hold the SHIFT key and drag the center handle, you'll notice
that instead of moving the entire handle array, you instead move around a tiny
“X"”. What you are doing is in fact separating the gradient's focus from its center
point - meaning that while the entire gradient is still based around that central
location, the gradient colors can be made to radiate from a point other than the
center. This is better seen than explained, so go ahead and try SHIFT+dragging
the center handle to the left and about to see what interesting lighting effect it
produces, such as the one shown on the right.

Notice that the highlight is placed off-center from the primary focus, and borders the surrounding gray
color much more abruptly. While this lighting effect is not particularly useful here, keep this in mind in
case you ever need to create a complex metallic or crystalline surface.

You may have noticed that the Fill Tab has two more icons, mainly the Pattern Fill icon:
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The Pattern Fill is essential for adding texture to your vector-based drawings, and will be discussed in
detail later in the chapter. The Unset Paint icon disables the color of your Fill, in order to allow any
Clones created from it to possess their own individual Fill color. You can't do anything with either one of
these options at this moment, so don't worry about them for now.

| : Stroke Paint Tab
I ['Stroke Eamt Description: Various tools to modify an object's Stroke color.

Upon clicking this tab, you'll notice that the menu remains virtually identical to Fill| " Stroke paint |=2Stroke style

the Fill Tab. That's because it essentially IS the same as the Fill Tab, with the |« Hoom 2
sole exception that all Flat Color, Linear Gradients and Radial Gradients | coior
will affect the outlying Stroke rather than the Fill. R Vihee!

For this reason, this chapter will pretty much end here as there really isn't
anything new that can be said about its usage. Just remember that while
adding colored lines does add a graceful layer of depth to illustrations -- and
are also essential for word art, photorealistic imitation and other special effects (255 [2)
- the industry standard for Anime-style cel drawings (and of course, black & seaaloosom |
white manga) is to use simply black lines.

Flat Color Linear Gradient Radial Gradient



I| =Stroke stgle Stroke Style Tab

Description: Various tools to modify an object's Stroke

As mentioned in the introduction, Strokes are one-dimensional lines with length but
no width, so while you can edit their direction to imitate any number of 2D/3D
shapes, you can't physically modify a Stroke's own width or shape directly in the
same way you can modify a Fill's shape using the Edit Tool.

Fortunately, the Stroke Style Tab will allow you to do just that - in fact, it's the
only thing you can use to modify Stroke settings as there are as yet no keyboard
shortcuts that can, for example, increase/decrease the width of a stroke.

In this current section, we'll draw a simple, 3-node “V” shape using the Line Tool
and see what we can do with it using the Stroke Style menu:

Width: [1.000 =] [ px 2]

S

With this spin button we can increase or decrease the width of the stroke on
demand. The dropdown box next to it also allows you to select the unit of
measurement you want to work with for the stroke width - although for the
sake of precision, it is recommended that you stick with “px” (“pixels”).

If we change the width value to 5.000, for example, the “V” shape will
naturally appear far thicker than before.

Jcin:‘E"(’:”/_l_l

The Join icons determine the behavior of Strokes that
intersect at a specific point, as shown in the cone-end
of the “V” shape. Leaving the “V” shape with its 5.000
width in place, you'll clearly notice that it currently uses
a Miter Join, meaning that Strokes intersect with
pointed edges.

The second icon, the Round Join, will create rounded
edges as shown in the first “V” on the right. And the
third icon, the Bevel Join, flattes out the edges as
shown in the second “V” on the right.

Miter limit: |4.00 -

This spin button is only enabled when the Miter Join icon is activated. Its value determines how
long you permit the pointed edge of a Miter Join to extend. If the pointed edge stretches beyond
the limit, the Join will flatten down to something resembling a Bevel Join. This is done because
pointed edges can often extend FAR beyond what you might desire in a picture, thus necessitating
this control mechanism.



As a visual example, try moving the upper-right hand
node of the “V” shape towards the left so that it's
positioned closer to the left hand node. Notice (in the
first “V” on the right) that even though you have Miter
Join selected, the intersecting end flattens out since
the resulting point extends far beyond the limit. Now
try extending that limit to 24.00, and notice (in the
second “V” on the right) that you can now get your
much desired point!

Just watch out, as it does (especially in this example), extend FAR beyond the simple confines of a
4.00 point Miter end.
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The Cap icons work in a similar way as the Join icons, but affect
the ends of a Stroke rather than just its intersections. The “V”
shape thus far has used Butt Cap ends, where the Stroke
essentially terminates on flat edges perpendicular to the end
nodes.

In contrast, the second icon called the Round Cap ends a stroke
with two rounded ends, not unlike the the Round Join from the
previous examples. This is rounding requires a little extra Stroke
“space” to be created past the end node, so be sure to use this if
stroke precision is not required.

The third icon, called the Square Cap, works in the exact same
way only it produces flat edges that extend beyond the end node.
Other than allowing lines to flatten out properly after a rolling
curve, there is virtually little use for Square Caps since they
visually look identical to Butt Caps.

Dashes:| ——— 2]/0.00 |2
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Like with most word processing programs that support lines, you can also - -
specify whether your stroke is one seamless line or composed of dashes of s b
various sizes or styles. For best results, reduce the width of your “V” shape % of
to 1.500 and resume usage of Butt Caps. Now select the second Dash * *
Pattern in its dropdown menu and notice how your “V” shape is now
composed of multiple dots instead.

Note that the spin button to the left is called the Pattern Offset and does
little more than shift the starting point for the dash pattern. You can't “
actually increase or decrease the number of dashes used without increasing

or decreasing the width of the Stroke itself.

As you can see below, though, there are many patterns to choose from for your purposes:




Start Markers: |. & Club c]

Mid Markers:| @ Dot | 2|

End Markers:l —.+ InfiniteLineEnd :Il

Finally, we come to the section on Markers, which are shapes that append
themselves to either the end nodes of a Stroke (the Start Markers and End °,
Markers, depending in which order the Stroke line was drawn) or the nodes e
in between (the Mid Markers). With the odd assortment of Markers shown

in the picture above, for example, our “V” shape mutates into the strange
piece of modern art shown to the right. Note that, just like with Dashes,
Markers also increase/decrease in size based on the width of the line.

Certainly the usefulness of Markers is suspect given that, for optimum
precision, it really is best to just drawn your own additions to a Stroke line.
Nevertheless, with a little creativity, you can use Markers to quickly create
simple shapes that need to be repeated frequently or are only minor details:

< K

And in case you're wondering, yes there are lots of Markers to use and all of them interchangeable
between Start Markers, Mid Markers and End Markers:

~— InfiniteLineStart —— TriangleOutS | DistanceOut
— InfiniteLineEnd - TriangleOutM | Distanceln
== RazorWire < TriangleOutL & Tail

% Club —— TriangleInS — Arrow2Send
- Torso — TrianglelnM — Arrow25start
—= Legs -4 TrianglelnL »— Arrow2Mend
< Scissors —— DiamondS —= Arrow2Mstart
- CurvyCross - DiamondM »— Arrow2Lend
=— CurveOut 4 DiamondL —a Arrow2Lstart
—& Curveln — SquareS — ArrowlSend
-+ SemiCircleOut s SquareM — Arrowl1Sstart
— SemiCircleln 4 SquarelL > ArrowlMend
— StopS — Dot _s —< Arrow1Mstart
—— StopM - Dot m » Arrowllend

—+ StoplL @ Dot_| —= Arrowllstart



Pattern Fills
Description: Use preset patterns to fill a Path.

You may remember that we glossed over this icon near the end of the x OOOE ? ole
section on Radial Gradients. This is because the Pattern Fill is a highly  Patternfill

useful and multi-faceted tool that, unlike its counterparts in Photoshop |
and other raster-based programs, plays a far more prominent and flexible

pattern3492 2 |

role. Therefore, an entire separate section is needed just to illustrate how Use Object >
. . i . Pattern > Objects
Pattern Fills can be used to enhance images, facilitate drawing of to Pattern to create
repetitive details, or supply much-needed texture to plain surfaces. a Tevi_pattem from
selection.

The premise behind the Pattern Fill is simple:

1) Create an object or series of objects as a template.

3) Go to Object>Pattern>Objects to Pattern to convert the group into a usable pattern (or

alternatively, hit ALT+1). Notice how several new handles now appear over the shape:
-0

4) And finally, select a Fill (or Stroke) you want to apply the pattern to, and click on the Pattern Fill
icon in the Fill and Stroke Window. Then entire Fill will be covered by default with the latest fill

(which in this case, is the one above), although you can use the drop-down menus to select
previous patterns used in your canvas:
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And that's basically the overall gist of it. Nothing really terrifying here.

Moreover, your Pattern designs are not necessarily permanent. When selecting your original grouped
object (now turned pattern), Object>Pattern>Pattern to Objects (or conversely, SHIFT+ALT+I1) will
revert the pattern back into your group. Here you can then update the shape using the Edit Tool, then

convert it back into a pattern for use in an updated Pattern Fill (although bear in mind a different Pattern
ID will be used).

W o~ Also of interest is the ability to modify the size, angle and position of the Pattern Fill itself.
When selecting a Pattern Fill with the Edit Tool, you will of course see whatever default
handles belong to the original Path, but you will also notice a strange handle set generally

hovering over the original pattern shape. Move the small “X” to reposition the Pattern Fill, the
small circle to rotate it, or the small square to resize it.

O




With a 45 degree angle shift and a significant size reduction, you can turn the red and blue “chessboard”-
like pattern used above into something as dynamic as the piece below:
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Moreover, in addition to being able to reselect this pattern for other fills, you can also duplicate the path
above (using CTRL+D, if you've forgotten) and it will still inherit the same Pattern Fill. Both the new
path, and its corresponding Pattern Fill, can be resized, rotated and repositioned at leisure to add more
interest:

Of course, producing simple square Pattern Fills, while certainly useful for a handful of design elements,
is hardly what one might consider “interesting”. Like the Star Tool, however, the Pattern Fill tool is a
very unimposing feature in Inkscape that can be used to produce an INFINITE number of unique, intriguing
and creative designs. If used properly, it can substitute for the lack of texturizing plugins found in most
raster-based applications.

Therefore, we're going to take some time to explore the following pattern examples (in incrementing
degrees of difficulty), in order to give you an idea of what to consider when working with this tool.
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